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INTRODUCTION

SMX-M8xx Series Cameras are megapixel CMOS cameras with USB2.0 interface
suitable for scientific and industrial applications. The cameras are designed for
capturing, streaming and storing high quality digital images.

SMX-M8xx Series Cameras are available in three modifications:
® SMX-M81M (1.3 megapixel, monochrome)

® SMX-M82C (2 megapixel, color)

® SMX-M83C (3 megapixel, color)

All the SMX-M8xx Cameras feature:

® Communication interface - USB2.0

® Form factor - a duralumin housing with C/CS - mount
Benefits of the SMX-M8xx Cameras are:

@ High speed

® Low power consumption

@ No external power supply required

® Ease of use

® Compactsize

Programmable functions include viewport window settings, adjustable exposure time
and gain, selectable sensor clock frequency and image decimation, flipping image
horizontally and vertically. The SMX-M8xx Series Cameras can be used in microscopy,
video conferencing, webcasting, surveillance and security systems, etc.

Introduction
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INSTALLATION AND
UPDATE

Before installing the camera software, install a USB2.0 adapter if needed. Install all
required drivers. Installation of the USB2.0 adapter is beyond the scope of this
document.

System Requirements

Operating System XP SP1+/2003/Vista/2008/7, recommended: Windows 7 or XP SP1 and higher

Processor Intel Pl or higher, recommended: Intel Core 2 Duo
Performance Minimum 300 Mflops, recommended: 400 Mflops or higher
Memory 256 MP for XP (512 MB for 2008/Vista/7), recommended: 512 MB (1024 MB)
USB 2.0 Recommended: Intel integrated Host Controller, not recommended: VIA-based
USB 3.0 Host Controller is also supported
Video 8 MB memory, recommended: GeForce 4xxx/Radeon 9xxx or higher
Installation

To install the SMX-M8xx camera application software:

1 Run the SMXM8X-<version>.exe file downloaded via the URL provided by Sumix
Corporation.

2 Welcome to the SMX-M8x USB 2.0 Camera Software Setup Wizard starts. The wiz-
ard will guide you through the software and hardware drivers installation. Close all
other applications that are running on your computer and then click the Next button
to continue the installation.

Installation and Update: System Requirements
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5! Setup - SMX-M8x USB2.0 Camera Software =] @ |

Welcome to the SMX-M8x USB2.0
Camera Software Setup Wizard

This will install SMX-Max USE2.0 Camera Software v1.4710 on
your computer,

It iz recommended that you dose all other applications before
continuing,

Click Next to continue, or Cancel to exit Setup.

[ Mext = ]| Cancel |

Figure 2-1 Welcome to the SMX-M8x Camera Setup Wizard

3 Inthe License Agreement box, read the license. Then select | accept the agree-
ment and click Next.

ﬁl Setup - SMX-M8x USB2.0 Camera Software

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

1. LICENSE AGREEMENT -

This software End User License Agreement (hereinafter referred to as EULA) is a
legal agreement between you, and Sumix Corporation (hereinafter referred to as
AIUTHOR) for the SMX-M3x IUSB2.0 Series Camera Software incuding any
endosed documentation and/or accompanying items (hereinafter referred to as
SOFTWARE).

This AGREEMENT states the terms and conditions upon which AUTHOR offers to
license the SOFTWARE.

This agreement is binding upon you as well as anyone taking any action with ~

@) [ accept the agreement

1 do not accept the agreement

| < Back |[ MNext = ]| Cancel

Figure 2-2 License Agreement dialog box

4 The wizard starts to check your system information. Upon completion, a table with
check results is displayed in the System Information box.

Installation and Update: Installation
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ﬁl Setup - SMX-M8x USB2.0 Camera Software

System Information
System Information collects your system configuration information.

05 Microsoft Windows 7 Ultimate (x64)
Processor(s) | Intel(R) Core(TM)2 Duo CPU T9400 @ 2.53GHz ~2534 MHz (2 CPU)
Performance | 737 Mflops
Memory 2045 MB
UsB2.0 USB2.0 controller found
Video MNVIDIA GeForce 9600M GT, 512 MB

I < Back ” MNext = ]l Cancel

I

Figure 2-3 System Information box

5 Do one of the following, depending on the results of the check:

® click the Next button if all table cells with system parameters are green (the
parameters satisfy the software requirements)

® update your system if at least one cell is red - such configuration is not recom-

mended

® update your system if at least one cell is yellow, otherwise the technical character-

istics declared for the camera will not be achieved.

To see the recommended system requirements, click the Requirements button in the
System Information dialog box:

ﬁl Setup - SMX-M8x USB2.0 Camera Software

System Information
System Information collects your system configuration information.

(0]

XP SP1+/2003/Vista/2008/7, recommended Win7 or XP SP1+

Processor(s)

Intel P4 or higher, recommended Intel Core 2 Duo

Performance

Minimum 300 Mflops, recommended - 400 Mflops or higher

Memory

XP - 256 ME (512 - 2008/Vista), recommended 512 MB (1024 ME)

USB2.0

Recommended Intel integrated controller, not recommended VIA-base|

Video

8 MB memory, recommended GeForce 4xx/Radeon 9xxx or higher

I < Back ” MNext = ]l Cancel

I

Figure 2-4 Recommended system configuration

Installation and Update: Installation
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6 In the Select Destination Location box, click Browse to change the folder in which
the SMX-M8xx camera application software will be installed, or leave the one sug-
gested by the wizard. Click Next.

5! Setup - SMX-M8x USB2.0 Camera Software =] @ |

Select Destination Location
Where should SMX-M8x USB2.0 Camera Software be installed?

| Setup will install SMX-Max USB2.0 Camera Software into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

:\Program Files\Sumix\SMX-Max USB2.0 Camera| Browse...

At least 11,8 MB of free disk space is required.

| < Back |[ MNext = ]| Cancel

Figure 2-5 Select Destination location box

7 Inthe same way, in the Select Start Menu Folder box, leave the suggested location
or specify the folder you wish. Click Next.

5! Setup - SMX-M8x USB2.0 Camera Software =] @ |

Select Start Menu Folder
Where should Setup place the program's shortcuts?

= i Setup will create the program's shortcuts in the following Start Menu folder,

To continue, dick Next. If you would like to select a different folder, dick Browse.

J5umix\SMX-MBx USB2.0 Camera) Browse...

| < Back |[ MNext = ]| Cancel

Figure 2-6 Select Start Menu Folder box

8 In the Ready to Install step, view the options you selected and click Install.

Installation and Update: Installation
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5! Setup - SMX-M8x USB2.0 Camera Software =] @ |

Ready to Install

Setup is now ready to begin installing SMX-M8x USB2.0 Camera Software on
your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\Program Files\Sumix\SMX-M8x USB2.0 Camera

Start Menu folder:
Sumix\SM¥X-M8x USB2.0 Camera

[ < Back ][ Install ][ Cancel

Figure 2-7 Ready to Install box

9 The wizard will start to install the application on your computer.

ﬁl Setup - SMX-M8x USB2.0 Camera Software

Installing

Please wait while Setup installs SMX-M3x USB2.0 Camera Software on your
computer,

Creating shortcuts. ..
C:\...\Drivers\Install SMX-M8x USB2.0 Camera driver (amda4).Ink

Cancel

Figure 2-8 Installing box

During the installation, the system will ask you whether you want to install the device
software. Press Install to proceed.

Installation and Update: Installation
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-] Windows Security @
Would you like to install this device software?

. Mame: Sumix Corporation Imaging devices
“:ej_l,(' = Publisher: Sumix Corporation

V| Always trust software from "Sumix Corporation”. Install |[ Don't Install

£ You should only install driver software from publishers you trust. How can [ decide
which device software is safe to install?

Figure 2-9 Windows Security box

10 On the last step, check the boxes for creating desktop and/or Quick Launch icons. If
you want to install the TWAIN driver, check the box for it (see “WIA” on page 53). If you
want to launch the camera application program right after finishing the installation,
check the box for it.

5! Setup - SMX-M8x USB2.0 Camera Software =] = | &=

Completing the SMX-M8x USB2.0
Camera Software Setup Wizard

Setup has finished installing SMX-M8x USB2.0 Camera
Software on your computer, The application may be launched
by selecting the installed icons.

Click Finish to exit Setup.

| Create a desktop icon

Create a Quick Launch icon

Launch SM¥-M8x USB2.0 Camera Application Program
V| Install a TWAIN driver

Figure 2-10 The last installation step

Note:  TWAIN driver can be also installed separately, using the \Sumix\SMX-M8x USB2.0 Camera\Drivers\TWAIN folder.
Browse to the Sumix folder that appears after the SMX-M8x USB2.0 Camera Software Setup Wizard installa-
tion and run the TWAIN driver setup (see “Installation” on page 69).

Note:  Ifyou face problems during the camera installation, see “Troubleshooter” on page 17.

The installation of the camera driver will be completed when you first connect the
camera to the computer’s USB port.

Installation and Update: Installation
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Driver Update

The camera application software is constantly developed and improved. When a new
version is available, the customers are notified and a new installer file is sent to them.

The update procedure is exactly the same as the installation described in the previous
section. Simply run the new installer SMXM8X<version>.exe and follow the wizard
(see “Installation” on page 9).

When a new camera driver version is available, you can update it via the Windows
device manage.

To update the camera driver:

1 Connect the camera to the computer.

2 Open the Device Manager window in the Control panel window.

3 Double-click Imaging devices.

4 Right-click SMX-M8x Series USB2.0 Camera and select Update Driver Software...

=y Device Manager EI@

File Action View Help
L AsEN P I Y

a 7 HP-HDX-16-001 -
b @ Batteries
A@ Biometric Devices
7y Validity Sensor

B Bluetooth Radios

18 Computer

\J Disk drives

. B Display adapters

> ¢4 DVD/CD-ROM drives

ng Human Interface Devices

b g IDE ATA/ATAPI controllers

b @ IEEE 1394 Bus host controllers

4= Imaging devices

Brother MFC-7820N LAN

aj HP Webcam

= SMX-M8x Series USB2.0 Camera

m

2= Keyboards Update Driver Software...
-l Mice and other pointing devices Disable
> - Monitors Uninstall
'i-." Metwork adapters
4[5 Other devices Scan for hardware changes

Base System Device

Base System Device Properties
Im Base Svstem Device

Launches the Update Driver Software Wizard for the selected de

Figure 2-11 Updating the camera driver

5 Follow the easy-on-screen instructions. On the first step, select Browse my com-
puter for driver software.

Installation and Update: Update
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b Update Driver Software - SMX-M8x Series USB2.0 Camera

How do you want to search for driver software?

= Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

= Browse my computer for driver software
Locate and install driver software manually.

Cancel |

Figure 2-12 Updating the camera driver: step1

6 On the next step, browse for the location on your computer where the driver is saved
and click Next.

@ Il Update Driver Software - SMX-M8x Series USB2.0 Camera

Browse for driver software on your computer

Search for driver software in this location:

-, Browse...

[¥] Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device,

MNext || Cancel

Figure 2-13 Updating the camera driver: step 2

7 The system will start installing the driver. In the end, a message that the installation is
successful will appear. Press Close to finish.

Installation and Update: Update
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Removal

To remove the camera application software, use the Add/Remove Programs section in
the Windows Control Panel. Remove the application according to the general
Windows application uninstallation rules.
Alternatively, you can click the uninstallation shortcut in the application folder (Start >
All Programs > Sumix > SMX-M8x USB2.0 Camera> Uninstall SMX-M8x USB2.0
Camera Software) and follow the uninstallation wizard.
After removing the software, you need also to remove the camera driver.
To remove the camera driver:
1 Connect the camera to the computer.
2 Open the Device Manager window in the Control panel window.
3 Double-click Imaging devices.
4 Right-click SMX-M8x Series USB2.0 Camera and select Uninstall.
5 Confirm removing the driver: check the Delete the driver software for this device

and click OK.

Confirm Device Uninstall @

= SMX-M8 Series USB2.0 Camera

‘ﬂ
Waming: You are about to uninstall this device from your system.
Delete the driver software for this device.
[ ok ][ cancel |

Figure 2-14 Driver removal confirmation
6 After the driver is uninstalled, the SMX-M8x Series USB2.0 Camera will disappear

from the Imaging Devices section of the Device Manager.

Troubleshooter

If you face problems with installation and detection of the camera, use this
Troubleshooter. If you face problems that are not described below, contact Sumix
Technical Department.

Note:  Tasks and problems in this section are demonstrated in Windows XP operating system.

Installation and Update: Removal
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Camera Was Not Detected or Recognized

If after connecting the camera to your computer the system does not detect it: there is

noicon % on the Taskbar or the camera was not recognized by the system:

ﬁ USE Device Mot Recognized

One of the USE devices attached ko this computer has
malfunctioned, and Windows does not recognize it
For assistance in solving this problem, click this message.

Try doing the following:

Check if the device was installed successfully: open system folder WINDOWS\
system32\drivers and check if there is the SMXM8X.sys file (normally it is located on
the C: hard disk). If not, run the driver installation again. Be sure that no camera is
connected during installation.

If the problem still persists, manually save the SMXM8X.sys file to the \WIN-
DOWS\system32\drivers folder (the SMXM8X.sys file is located in the \Sumix\SMX-M8x
USB2.0 Camera\Drivers folder).

If the problem still persists, try one of the following:

Reconnect the camera.

Use other USB2.0 port of your computer - the problem might be due to the USB2.0
port malfunction.

Use another USB2.0 cable - the problem might be due to the USB2.0 cable malfunc-
tion.

Connect other SMX-M8xx camera (if any) to the same USB2.0 port - the problem
might be due to the camera malfunction.

Disconnect the camera and restart your computer.

If any of the above steps did not help and the device is not recognized yet, try the
following:

1
2

Connect the problematical camera to the computer.

Open the Device Manager window (right-lick My Computer desktop icon, select
Properties, select Hardware tab, and then click Device Manager).

In Device Manager, double-click Universal Serial Bus controllers.

4 In Device Manager, select one of the following:

® Imaging devices> SMX-M8x Series USB2.0 Camera with Warning status, if it is
available there:

Installation and Update: Troubleshooter
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Device Manager

B

File  Action Wiew Help

o B ES 2 A xRS

E g" MAaRY
] 8 } Computer
| ag# Disk drives
] § Display adapters
1k DVDJCD-ROM drives
|- =% Floppy disk controllers
1 g Floppy disk drives
|-{#8 Human Interface Devices
1= IDE ATAJATAPT controllers
=8 Imaging devices
=1 SMR-MEX Series LISE2,0 Camera;
‘22 Keyboards
J Mice and other pointing devices
|- & Manitars
|- E8 Network adapters
| Ports (COM&LPT)
] ﬂ Processars
| @, sound, video and game controllers

1 i System devices
] Universal Serial Bus controllers

F- - [ F-F- -

Figure 2-15 Device Manager: the SMX-M8x camera with Warning status

® Universal Serial Bus controllers> Unknown device:

Device Manager

BEX

File  Action Wiew Help

o BES 2
+ ") Mice and other pointing devices
+ @ Monitors

+- B8 Network adapters

- Ports (COM &LPT)

+ ﬂ Processars

+ @, sound, video and game controllers

+- by System devices

= é Universal Serial Bus controllers

&2 Generic USE Hub

= Inkel{R) 82801EE USE Universal Host Controller - 2402
= Inkel{R) 82801EE USE Universal Host Controller - 2404
Intel{R) 82801EE USE Universal Host Controller - 2407
= Intel{R) 828016 USE Universal Host Controller - 24DE
= Intel(R) 52801EE 1USE2 Enhanced Host Contraller - 2400

= |JSE Root Hub
= 1ISE Root Hub
= 1ISE Root Hub
= 1ISE Root Hub

=]

[

Figure 2-16 Device Manager: the SMX-M8x camera is detected as Unknown device

5 Right-click and select Update Driver...:

Installation and Update: Troubleshooter
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Eé Device M

S]]

File  Action Wiew Help

mEFS 2 A =Ra

+ -5] Monitars

+ - B8 Network adapters

- F Ports (COM&LPT)

+ * Processors

+ Q) Sound, video and game controllers

+ Syskem devices

= é Universal Serial Bus controllers

* Intel{R) 82801EE USE Universal Host Controller - 2402
Intel{R) 82801EE USE Universal Host Controller - 2404
Intel{R) 82801EE USE Universal Host Controller - 2407
Intel{R) 82801EE USE Universal Host Controller - 24DE
#=b Standard Enhanced PCT o UISE Host Controller

&= Unknown Devii
e UsE Root Hub
= USE Root Hub
&= ISE Root Hub
& USE Root Hub |
USE Root Hub Properties

Update Driver,..
Disable
Uninstall

Scan for hardware changes

Launches the Hardware Update Wizard for the selected device,

e — .

Figure 2-17 Device Manager: Updating the SMX-M8x camera driver

Run the Hardware Update Wizard the same way as the Found New Hardware Wizard
by choosing the Install the software automatically (Recommended) option:

Hardware Update Wizard

I Thiz wizard helpz you install software for:

S8 Series USB2.0 Camera

“Zi or floppy disk. insert it now.

‘what do you want the wizard to do?

{ .'j If your hardware came with an installation CD

(O Install fram a list or zpecific location (Advanced)

Click Mest to continue.

I < Back ” Mest » ]l Cancel

]

Figure 2-18 Hardware Update Wizard: the Welcome window

6 If some problems occur during the manual hardware installation, read the next sec-

tion of this Troubleshooter.

Cannot Install the Hardware

If the Found New Hardware Wizard\Hardware Update Wizard failed to install the
hardware (the wizard that starts after the first connection of the camera or the Wizard
that starts for updating the hardware; failure occurs after you browse to the files needed

for the installing),

Installation and Update: Troubleshooter
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Found Mew Hardware Wizard

Cannot Install this Hardware
g
&

The hardware was not installed becauze the wizard cannot find
the neceszary software,

when this computer connects to the Internet, Windows Update
will zearch for the right software and notify you if it becomes
available.

irJ Click Back if you have installation media such as a
" CD-ROM, or if you know the location of the software,

3 Click Finizh to go to Help and Support Center for further
. help installing thiz hardware,

[ < Back ” Finizh ][ Cancel ]

Figure 2-19 Found New Hardware Wizard: Cannot install this Hardware

try doing the following:

1 Click Back in the Found New Hardware Wizard and select Install from a list or spe-
cific location (Advanced).

2 C(lick Next.

Hardware Update Wizard

5

Thiz wizard helpz you install software for:

Shdx-MEx Series USB2.0 Camera

{ ') If your hardware came with an installation CD
= or floppy disk. insert it now.

1.

what do you want the wi

2.

Click Mest to continue.

e e

Figure 2-20 Found New Hardware Wizard: Installing from a list or specific location (Advanced)

3 Select Search for the best driver in these locations.
Check the Include this location in the search box.

5 Browse to the Drivers folder - on the SMX-M8x Camera CD or in the Sumix\SMX-M8x
USB2.0 Camera folder (located on the hard disk where you installed the SMX-M8x
Camera Software, normally it is the C:\Program Files\Sumix\SMX-M8x USB2.0
Camera).

6 Click Next.

Installation and Update: Troubleshooter
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Hardware Update Wizard

Please choose your search and installation options. o
3.
(%) Search for the best driver in these locations.

Uze the check boxes below to limit or expand the default search, which includes local
4, paths and remaovable media. The best driver found will be installed. 5

[ Search removable media (floppy, CO-ROM...)

Include this location in the search:
gram FileghSumixhShi-k8x LUSE 2.0 CameratDrivers | v

() Don't search. | will choose the driver to install

Chooze thiz option to select the device driver from a list. Windows does not guarantee that
the driver you chooze will be the best match for your hardware.

[ < Back ] Mest » ][ Cancel ]

Figure 2-21 Installing from a list or specific location: specifying location

7 Inthe list, select the last item.

8 Click Next.

9 Wait till the wizard installs all files.

10 Click Finish if installation passed successfully.

Installation and Update: Troubleshooter



GETTING STARTED

Installing Lens

To use a lens with the camera, remove the cover from the camera and install a lens as
described below.

It is recommended to remove the cover and install a lens (as well as remove a lens and
put on the cover) when the camera is faced down, to prevent the sensor contamination.

Toinstall alens:

1 Face the camera down.

2 Remove the camera cover.
3 Screw thelensin.

To remove the lens

1 Face the camera down.

2 Screw the lens out.

3 Puton the cover.

Note:  Before screwing the lens in or putting on the cover, make sure that the surfaces are free from dust

When you remove the cover, put it facing down to keep dust out

=

Recommendations on the Camera Connection

Most computers have both front and back USB2.0 ports location. We do not
recommend using the front USB2.0 port of your computer since it is not directly
connected to the computer's USB Host Controller.

Getting Started
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front USB2.0

port
| —

PCIUSB2.0

Integrated USB2.0
controller

As shown on the picture above, the front USB2.0 port is connected to the USB Host
Controller by long cables inside computer, meanwhile back USB2.0 port is connected
directly to its controller at the back panel of computer.

So, when connecting the camera to the front USB2.0 port the device might not work
properly. We recommend to use the back USB2.0 port to avoid problems with the
camera work (see the picture below).

Note:  Design and configuration of the front USB2.0 port location shown on the pictures above might differ from yours.
The pictures' goal is only to show how the front USB2.0 port is connected to its controller

Plugging in the Camera

Connect SMX-M8xx camera with USB2.0 cable.
Connect the other end of the USB cable to the back USB2.0 port of your computer.

Getting Started
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Installing Driver Software

Note

After you connect the camera to the USB port of you computer, a Found New
Hardware message will appear in the notification area of the task bar, and Windows will
install the hardware driver. When the installation is finished, a message will appear in
the notification area:

=

== SMX-M8x Series USB2.0 Camera

i - - -
=¥ Device driver software installed successfully.
A,

Figure 3-1 Notification about successful camera installation

If you experience problems during the driver software installation, refer to the Installation Troubleshooter and
learn how to fix such problems (see “Troubleshooter” on page 17).

Starting the Application

After the camera hardware has been installed, you can start the application.
To start the camera application:

Click Start > All Programs > Sumix > SMX-M8x USB2.0 Camera > SMX-M8x USB2.0
Camera Application Program. If during the installation you chose to install a desktop
icon and/or a quick launch icon, you can also click the icon to launch the application.
The SMX-M8xx application will start with its main window.

The SMX-M8xx application consists of the following parts:

@ Main window which contains the main functions. On the top of the main window,
there is an application toolbar:

Getting Started
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Note:

Getting Started

&) SMX-Mx Series USB2.0 Camera | = | & ||

File Edit Device Help

®|u|m ||t e
Sensor Control
— Exposure Gain Frequency
18,40 ms 90 90 90 90 ,—_|
12MHz  ~
rrrr o
—— Decimation
-
—— Wiewwport [pix] —
1600 = 1200
at0.0
Al R G B Ceti
[ Lock Ratio AT

Image Carrection | Coalor Balance | Color Comrection |
[~ Enable _ Best D efault

Brightresz 0
Contrast 0
Gamma [ 1.00

Snapshot

[~ Loop
Timeout [zec) |5 %] [~ Estemal Trigger

SMX-M82 Color Ready Zoom1x |50 fps

Figure 3-2 SMX-M8xx application main window

@ Histogram which reflects all color settings of the camera.

To open the histogram:
Press the h button on the keyboard or select Histogram from the Device menu.

Histogram @

|

Min: 0 Avg:179,70 Mazx: 255

Figure 3-3 Camera histogram
The histogram window is empty when the video is not started.

® Device Settings window contains the camera settings.

To open the Device Settings window:

Select Settings from the Device menu or press Alt+s on the keyboard.
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r— Camera Info
Shdx-#82 Color ISB2.0 Camera

Max Resolution: 1600x1200
Device ID: 2027.19.1.2.0 &l

r— Color Mode — 1 Flip Image Average Frames —
" Maonochrome . & Disable
I™ Horizantal || ~ | 20t N frames

 Bilinear I Vetical " Pack M frames

™ Laplacian Frames: |10 %

r— External Trigger Polarity Max Exposure
m I~ Limit Max Exposure
ozitive ¥
I‘IDD ms Setl

r— Black Level Calibration ' alue

I

[ Direct Access To Driver Frame Memany  FrameR ate |
V¥ Enable Image Corection [~ 10bit mode
[ Display “ideo on Program Statup [ Median Filter
[~ Auto White Balance Hardware [~ Limit Gain 10
[~ Auto White Balance Software

[~ Show OnlyValid Frames

Figure 3-4 Device Settings window

® Video mode window which shows a live view from the camera and reflects all set-
tings of the image

Figure 3-5 Video mode window

To start video from the camera:

Click the Start Video button in the toolbar:

Getting Started -
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Note:

i3
OR

Select Start Video from the Device menu.

To display video right after you enter the application, select the Display Video on Program Startup check box
in the Device Settings window. Then you will not need to click the Start Video button.

If the Start Video button is not active, in the SMX-M8x Series USB2.0 Camera
Software main window, click Device menu, select Switch Multiple... and select the
connected camera.

Switching Between Cameras

If you have more than one SMX-M8xx Series camera connected to your PC, the camera
application allows you to switch between them.

To switch between multiple cameras:

1 Inthe Device menu of the application’s main window, select the Switch Multiple
command.

2 The Choose a Camera window will appear.

Q Choose a Camer... EI@

0: 5 _olor Camera [2027]

ono Camera [1865]

(] 8 | Cancel

Figure 3-6 Switching between cameras

3 Inthe list of the present cameras, select the desired one and click OK.

Viewing Camera ID

Getting Started

The camera ID is shown on the top of the Device Settings window.

Device Settings
Camera Info

Shx-150M USE2.0 Camera
W 2 4 Cloze

evice |D: 2256.3.8.14.34

Figure 3-7 Camera ID
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Reducing CPU Load

You can reduce CPU load by enabling the Direct Access to Driver Frame Memory
option at the bottom of Device Settings window. See APl documentation for the

details on how to provide direct pointer to the driver frame memory instead of copying
the frame to the user buffer.

Getting Started
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TUNING GUIDELINES

Initial Settings

Check if the Start Video button on the camera application’s toolbar is enabled:

|

If

it is not enabled, check the list of all available cameras in Main menu > Device >

Switch Multiple... If the list is empty, check if the camera is connected and if the driver

is

installed correctly.

The illumination of the camera’s image depends on the values of frequency, exposure,
gain, the image dimensions (resolution) and decimation factor.

The recommended initial settings are:

@ Gain and Exposure sliders are in the lowest position
® Decimationis 1:1
@ Viewport size is 800 x 600 (the Viewport settings dialog box is activated with the
button on the camera application toolbar or Alt + v on the keyboard)
® Color Mode is set to Bilinear (Main Menu > Device > Settings... dialog box, Color
Mode section)
@ Histogram is active (Main menu >Device > Histogram is selected or h is pressed)
Histogram @
Min: 0 Avg: 1,00 Max: 1

Figure 4-1 Histogram of initial state

® Thelmage Correction tab is selected

® The Enable check box is set

The Brightness, Contrast, Gamma sliders of the Image Correction tab are in the
central position (their values are 0, 1, 1, respectively). To reset the values for all sliders
at one go, click the Default button. To reset one of them, double-click its value at the
right end of the slider bar

The R, G, B sliders of the Color Balance tab are in the central position (their values
are 1, 1, 1, respectively). To reset the values for all sliders at one go, click the Default
button. To reset one of them, double-click its value at right end of the slider bar

Tuning Guidelines: Initial Settings
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Note:

@ The Brightness, Contrast, Saturation sliders of the Color Correction tab are in the
central position (their values are 0, 1, 1 - respectively). To reset the values for all slid-
ers at one go, click the Default button. To reset one of them, double-click its value at
right end of the slider bar

The slider values will affect the image, only if the Enable box is checked.

Tuning Light in the Image

Color Tuning

To tune illumination, install a lens (see “Installing Driver Software” on page 25).

To tune light in the image:
1 Use maximum diaphragm aperture of your lens.
2 Try to get enough light using the Exposure slider.

3 If the Exposure slider is at maximum and more light is needed, decrease frequency
(it will enlarge the exposure interval).

If ilumination is not enough, use the Gain group of sliders (All, R, G, B).
5 Press e on the keyboard to adjust the exposure automatically.

Histogram @
Min: 12 Avg: 2847 Mazx: 247

Figure 4-2 Histogram after illumination is tuned

6 If the image is still too dark, you can also change black level:
a. Open the Device Setting window by pressing Alt+s.

b. Go to the Black Level Calibration Value control and move the slider until the
image becomes as bright as you need.

Black Level Calibration alue

I
T

Figure 4-3 Black Level Calibration control

To tune color of the image:
1 Putawhite object (for example, a piece of paper) in front of the camera.

2 Perform White Balance (Hard): select Device > White Balance (Hard) or press
Alt+w. It will balance the RGB components of white at the hardware level.

Tuning Guidelines: Tuning Light in the Image
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3 Select Main > Device > White Balance (Soft) item or press w on the keyboard (color
balance at software level).

To control the color components, use the R, G, B sliders of the Color Balance tab and
the Brightness, Contrast and Saturation sliders of the Color Correction tab.

Histogram @
Min: 1 Avg: 12,28 Max: 23

Figure 4-4 Histogram after performing White Balance (Soft)

Contrast Tuning

Activate the Histogram (H), activate the Image Correction tab, set the Enable check
box and use the Contrast slider to get the histogram as wide as possible (ideal min =0,
max = 255 provided there are no red points at the extremities of the histogram
window).

Sensor Controls

Exposure

The sensor control options are located in the Sensor Control section of the application
main window. They are as follows.

Sensor Control
— Exposure Gain Frequency

56,79 ms 26 30 23 332
et 12MHz =

—— Decimation
11 hd

—— Wiewport [pix] —
-‘7 T ( 800 « 600

]— at 400, 300
AREE Settings...
I~ Lock Ratio

Figure 4-5 Sensor controls

The exposure parameter defines time during which the sensor will consume light
energy before starting to record data.

Use the Exposure slider to adjust the camera exposure time manually. The current
exposure time in milliseconds is displayed above the control. This value depends on
viewport height, decimation and sensor frequency.

Tuning Guidelines: Contrast Tuning
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Gain

Note:

Frequency

Decimation

Tuning Guidelines:

If you need to set exposure even higher than the maximum slider value, use the Max
Exposure control in the Device Settings window. Check the Limit Max Exposure box,
enter new limit value and press Set.

External Trigger Polarity Max Exposure
m [ Limit Max Exposure
ositive ¥
100 ms Set

Figure 4-6 Max Exposure control

To tune exposure automatically:

In the Device menu select the Auto Exposure command, or press E on the keyboard.

Gain can be controlled independently for Red, Green and Blue channels (R, G, B). All
gain sliders control the camera’s hardware gain amplifier. The R, G and B gain sliders
control the software gain for each color channel.

Checking the Lock Ratio check box allows controlling gain on three channels
simultaneously keeping the fixed R; G; B gain ratio.

Use the 'White balance (Hard)' menu item (Device> White Balance (Hard) or Alt+w to
balance the gain of all three channels so they are equally intense.

Auto Exposure is done automatically every time White Balance (Hard) is performed.

In case of SMX-M81M monochrome camera, set gain using the All slider.

You can limit the maximal set gain value to 10. Use the Limit Gain 10 checkbox in the
Device Settings window.

™ Median Filter

| r LimitGain‘IDl

Figure 4-7 Limit Gain control

If this box is checked, you will not be able to set gain higher than 10.

The Frequency drop-down box provides values for the pixel clock frequency of the
sensor. The lower the frequency, the higher the maximum possible exposure time and
the less the frame rate is. This control defines the frequency of polling the camera for its
image stream.

Use the Decimation drop-down box to decimate (sub-sample) the picture by 2, 4 or 8.
The decimation means excluding pixels and rows from the scan process (for example,
every second pixel and second row for the 1:2 decimation). This mode thus allows
viewing the picture at the higher frame rate.

Sensor Controls
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The higher decimation can be used for preview, when the full 1600 x 1200 image can be
displayed as 800 x 600 with the frame rate two times higher.

Viewport is a rectangular area of the sensor on which the image is scanned. It can have
variable size: from the full sensor field of view to the small area of 8 x 8 pixels. The
smaller vertical size (in lines) of the viewport, the faster the scan process and the higher
the frame rate is.

To change the viewport:
1 Press Alt+v on the keyboard

OR

Click the Settings... button below Viewport (pix)
OR

Click the Viewport Settings button on the toolbar:

]

2 The Viewport Settings window will open.

Viewport Settings @

Cloze

Fredefined
" 320x240
" 400x400
" B40x480
" TEExETE
" 800x600
" 1024x768
" 1280x1024

Offset: = |0 Y |0 Size: ¥ |2048 v |1536

Figure 4-8 Viewport Settings window

3 You can select one of the predefined viewport options and then drag the rectangle
across the full viewport resolution area for the viewport window. You will notice how
the image in the View Mode window changes with the movement.

4 Alternatively, you can change values in the following fields:
@ OffsetX, Y fields with coordinates of the top left corner of the rectangle

® Size X, Y fields with coordinates of the bottom right corner of the rectangle

Tuning Guidelines: Sensor Controls
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If the viewport size is smaller than maximum viewport size, you can also change it by
dragging the video image in the Video mode window.

Image Correction

Note

Color Balance

The Image Correction controls are designed for setting up the camera brightness,
contrast and gamma. These corrections are programmable with the conversion (lookup)
table of the values. They do not affect any electrical settings of the camera. The gamma
correction is done by the camera hardware.

Image Correction | Color Balance | Color Correction

W Enable Best | [£Ff

Brightress 0
Contragt ©—————— 10
Gamma 100

Figure 4-9 Image correction controls

To use these controls, check the Enable box - the Brightness, Contrast and Gamma
sliders become editable. By default, the values of Brightness, Contrast and Gamma are
setto 0; 0; 1, 00, respectively.

You can restore the default values at any step, just click the Default button on the
Image Correction tab.

Click the Best button to automatically achieve the optimal combination of brightness,
contrast and gamma instead of setting them manually. As the result, the application will
transform the look-up table of 8 and 10 bit to increase the dynamic range.

The default values of Image Correction are the most suitable and recommended for performing White Balance
(Hard).

The SMX-M8x camera software does not display changes of the Image Correction look -up table when the Best
button is pressed.

With every change of any Image Correction control, you can view a graphical
interpretation of dependence of the image's changes from the changes of the Image
Correction controls.

The Color Balance Controls are designed for the SMX-M82C and SMX-M83C (color)
models to adjust the ratio of the main induced color components (Red, Green and
Blue) of the image. This correction is performed on the software level and does not
affect any electrical settings of the camera.

To use the Color Balance Controls, set the Enable check box on the Color Balance tab
- R, G and B sliders become editable.

Tuning Guidelines: Image Correction
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Image Corection  Color Balance | Color Correction |
[v¥ Enable D efault | “white: Balance|
R I 0.76
Gr I 1.05
Bir I 1137

Figure 4-10 Enabling the Color Balance Controls

Use the White Balance button for white color balancing (the same can be done in
Device> White Balance or by pressing w on the keyboard) on the Color Balance tab.
The Default button returns the color balance controls to their default values: 1.00; 1.00;
1.00, respectively.

Single step of the Color Balance controls is 10 times smaller than R, G, B (Gain) of the
Sensor Controls, so all changes of Color Balance can be performed with more
accuracy than it can be done using R, G, B (Gain) of Sensor Controls.

The difference between White balance (Soft) and White Balance (Hard) is as follows: the White Balance (Soft)
operation is done only on the software level, so it changes the Color Balance controls. The White Balance
(Hard) operation is done programmatically by the camera firmware, so it changes R, G and B (Gain) of Sensor
Controls.

It is not recommended to perform White Balance (Hard) when White Balance (Soft) is already performed. It
may cause the image colors distortion.

Color Correction

The Color Correction Controls are designed for the SMX-M82C and SMX-M83C (color)
models to adjust the intensity of the color properties (brightness, contrast and
saturation) of the image. This correction is performed on the software level and does
not affect any electrical settings of the camera.

Check the Enable check box on the Color Correction tab to make the Color Correction
Controls available.

Image Carrection | Color Balance  Color Carrection

D efault
I 0.00
Contrast T I 1.00
Saturation T I 1.00

Figure 4-11 Enabling the Color Correction tab

Use the Default button to restore the default values of brightness, contrast and
saturation - 0.0; 1.00; 1.00, respectively.

Tuning Guidelines: Color Correction
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Advanced Sensor Controls

Color Mode

Image Flip

Apart of the controls in the main application window, you can also use controls
available in the Device Settings window. To access the Device Settings window, press
Alt+s on the keyboard or select Settings from the Device menu.

The Color Mode section defines the rules for decoding the stream of source pixels from
the sensor and transforming it into the output image. This control is available for the
SMX-M82C and SMX-M83C color models.

Device Settings @
Camera Info

Shdx-#82 Color ISB2.0 Camera

Max Resolution: 1600x1200 Close

Device ID: 2027.19.1.2.0
Color Mode Flip Image Average Frames
" Monochrome + Disable

" Mearest Color I Horizontal ||~ | a5t N frames
o : " Pack M frames

[~ Wertical
placian Frames: (10 %

Figure 4-12 Advanced sensor controls

® The Monochrome mode forces the transformation of the sensor pixels data into
monochrome stream.

@ The Nearest Color mode: Bayer matrix from the sensor is transformed into destina-
tion stream using the Nearest Color algorithm (the fastest algorithm that gives the
worst, compared to other algorithms, image quality).

@ The Bilinear mode: Bayer matrix from the sensor is transformed into destination
stream using the Bilinear algorithm (a slower algorithm that gives better quality).

® The Laplacian mode: Bayer matrix from the sensor is transformed into destination
stream using the Linear Interpolation with Laplacian second-order correction terms
(the slowest algorithm that gives the best quality).

You can flip the image in the Video mode window horizontally and/or vertically. Check
the corresponding boxes in the Flip Image section of the Device Settings window.
Using the flip controls, you can rotate the image without changing the camera position
itself.

Increasing Image Quality

You can increase the image quality by compensating the random noise of the sensor.
For this purpose, use the Average Frames controls in the Device Settings window.

There are two averaging modes:

@ Last N frames: the currently displayed frame is the average of the last N frames set in
the Frames box. The picture is updating every frame

Tuning Guidelines: Advanced Sensor Controls
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® Pack N Frames: the currently displayed frame is the average of the last N frames set
in the Frames box. The picture is updating every N-th frame.

Use the averaging only for static pictures. Displaying moving objects in the average mode will lead to the image
blurring.

You can change the frame rate for the current sensor parameters (for example,
frequency or viewport) using the FrameRate Control button in the lower part of the
Device Settings window.

To change frame rate:
1 Open the Device Settings window by pressing Alt+s on the keyboard.
2 Press the FrameRate Control button.

Frame Rate Control @
Frame Fate: [fps]

Set Default | Set Maximum|

| 10 bit mode

Figure 4-13 The Frame Rate Control window

3 The Frame Rate Control box opens. By default, it shows the maximum value for the
current sensor parameters.

4 Type in the new value in the Frame Rate field, then press Set. You will not be able to
set frame rate lower or greater than limits. To check the maximum limit, press the Set
Maximum button.

The Set Default button - if applied, the default value of frame rate for the camera with
current settings will be performed. The default value is flashed in every camera and is
applied automatically when the camera’s settings are changed.

For the Snapshot Loop mode, it is recommended to use the default value of frame rate

As a result, the Frame Rate value will not be greater than the one you entered in the
Frame Rate Control window. Check it when running video: frame rate value will be
displayed at the bottom-right corner of the status bar in the application's main window.

When running the camera on a system that does not meet the minimal requirements (see “System Require-
ments” on page 9), the frame rate value can be less than it is set with the Frame Rate Control option, espe-
cially when running with full viewport and with high frequencies.

These controls are used for the SMX-M82C and SMX-M83C color camera models.

Enable the Auto White Balance Hardware and/or Auto White Balance Software
checkboxes if you want to automatically balance white at the hardware and/or software

Tuning Guidelines: Advanced Sensor Controls
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levels every time when the picture changes. For Auto White Balance Software
operation, check also the Enable box on the Color Balance tab of the main window.

Figure 4-14 Auto White Balance checkboxes

For more information on white balance, see “Color Balance” on page 36.

Output Bits per Pixel

If the Use 10 bits box is checked, it enables the software to transmit 10 bit images from
the camera as opposed to regular 8 bit.

[~ Use 10 Bits

Figure 4-15 70 bit mode checkbox
Filtering

The Median Filter option turns on pixel averaging. The brightness of every single pixel
becomes affected by the brightness of its neighbor pixels and the whole image
becomes smoother.

| b edian Filter

Figure 4-16 Median Filter checkbox

Removing Error Frames

SMX-M8xx Series cameras can sometimes record frames with errors. To ignore and
remove such error frames, check the Show Only Valid Frames box in the bottom of the
Device Settings window.

Figure 4-17 Show Only Valid Frames checkbox

Saving and Loading Camera Profiles

The SMX-M8xx camera application automatically stores most of the camera settings on
exit and restores them on startup. You can also store current settings in profile files
(*.pro) and load them whenever you need. Profiles store frequency, gain, exposure,
viewport, flip, black level and column balancing, and other settings.

To save current camera settings into a profile:
1 Press Ctrl+s.

Tuning Guidelines: Saving and Loading Camera Profiles
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OR

In the File menu select the Save Profile command.

2 Save Camera Profile box appears. Type in profile title and select a folder where you
want to save the file.

@ Save Camera Profile @
Save in: test j £k B~
<5
Recent Places
Desktop
= l.pro
Lil;varies
Computer
“
Network
File name: |2 j Save |
Save as type: |Pr0ﬁ|e Files {*.pro) j Cancel

Figure 4-18 Saving camera profile

3 Press Save.
To load a profile:
1 Press Ctrl+o or in the File menu, select the Open Profile command.

2 Load Camera Profile box appears. Browse to a folder with profile files and select one
you want to load.

Tuning Guidelines: Saving and Loading Camera Profiles
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Q Load Camera Profile @
Look in: | | test j EF '
e B L i

Recent Places

Desktop
= l.pro 2.pro
u=a})

Libraries

Computer

“w

Network

File name: |2 j Open |
Files of type: |Pr0ﬁ|e Files (*pro} j Cancel

Figure 4-19 Loading camera profile

3 Press Open.

Tuning Guidelines: Saving and Loading Camera Profiles



CAPTURING

The SMX-M8xx camera application enables you to capture images from the camera and
to store them in BMP or TIFF format files. You can also save files with video that you
record.

Capturing Images

Capture Limits

To capture frames:
1 Start video (press F5 or the button » | Start Video in the toolbar).
2 You can capture a single frame or a frame sequence:

® Forasingle frame press F2 or the button @ in the toolbar

® Fora sequence press F3 or the button &/ in the toolbar.

3 The frame/frame sequence is captured immediately and saved in the folder specified
in Capture Options (see “Saving Options” on page 45).

The Limits section in the Capture Options dialog box allows controlling the capture
parameters. To open the dialog box, press Alt+c on the keyboard.

You can lower the noise level in the frame being captured using the Capture single
frame as average of box. Check the box and type in the number of frame you want to
average.

Lirnits

[v Capture single frame as average of |2 frames

@ Limit sequence counti [2 frames
™ Snapshot Save Only

Capture a frame every 100 ms

Figure 5-1 Limits section of Capture Options

By default, two frames are captured in a sequence. You can increase this value:
1 Check the Limit sequence count to box.
2 Type in the new value in the field near the checkbox.

3 Change the time period for capturing frames in the Capture a frame every field. The
sequence capture interval cannot be less than current frame exposure time. If it is
less, an error message will be displayed when you try to perform a sequence capture:

Capturing



SMX-M8xx Series USB2.0 Camera User Guide

Error

i - ) The sequence capture interval (1 ms) is less than current exposure time (8,92 ms).

Please set correct interval in the Capture Options.

Figure 5-2 Message about incorrect sequence capture interval

4 Press OK.

Recording Video

To record a video:

1 Start video (press F5 or the button » | Start Video in the toolbar).

2 To start video recording, press F4 or the button & in the toolbar.

3 Press Shitf+F5 to stop the video stream or click the o] Stop Video button in the
toolbar.

4 The video is recorded and saved in the folder specified in Capture Options (see “Sav-
ing Options” on page 45) as an .avi file.

Saving Video to Memory

Capturing

You can save video or frames to the core memory. This is done without a delay between
frames. Do the following:

1 Start video.

2 Pressthe =1 Save Video to Memory button in the toolbar or press Shift+F4 on the
keyboard.

Number of frames in the video is set via the Capture Options box. Type in the required
number in the Capture Limit field:

Capture Limit: {100

Figure 5-3 Save Video to Memory section

When you use the Save to Memory option, frames will be saved as image files similarly
to the simple saving (see “Saving Options” on page 45). Video will be saved as a .smx file
which can be replayed and converted to the .avi file with the SMXView utility that goes
with the standard SMX-M8x software package.

Saving video directly to memory can slow down the camera’s output visualization, but
this method insures that no frames are missing in the saved file.
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Saving Options

When you capture frames or record a video, they are saved in directory and with file
prefix specified in Capture Options.

To change options for saving frames/video:

1 Open the Capture Options dialog by pressing Alt+c on the keyboard or go to the
File menu and select Capture Options.

SMX-M8x Capture Options @

Picture File Store Folder

C:A\UszershlgortDesklop gg

File Mame Prefizes

Single Frame |FRAME_ Fomat...

. 0 " BMP
equence _
@+ TIFF |NOME =
ideo WIDEO_
L.E'.'.'I

Lirnits

[~ Capture single frame as average of |2 frames

[~ Limit sequence count to |2 frames

I” Snapshot Save Onl
Capture a frame every |1 TS i 4

Save Video to Memory

Capture Limit: {100 oK, | Cancel

Figure 5-4 Capture Options box

2 Set the options:

a. Inthe Picture File Store Folder box, change the directory in which you want to
save frames/video or leave the default one.

Note:  This folder will also store snapshots (see "Snapshots” on page 47).

b. Change the prefix that will be assigned to all frame/frame sequence and video
files or leave the default ones. Use the Single Frame, Sequence and Video fields.
The files are named automatically by combining the corresponding File Name
Prefix and numerical value that is calculated by the number of last captured file +
1.

c. Selectimage file format for frames:
® BMP -saves any 8 bit or 10 bit image as 8 bit BMP image.

@ TIFF - saves 8 bit image as 8 bit TIFF image and 10 bit image as 10 bit TIFF image.
Select also compression type: NONE (without compression) or LZW (Lemple-Zif-
Welch - lossless type of compression).

Note:  The selected image format will also be used for snapshots.

3 Press OK.

Capturing
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SNAPSHOTS

Snapshots Basics

The SMX-M8xx Series cameras can work only in one of the two modes at the same time:
Video or Snapshot. When the camera is not in the video mode, it is possible to take a
snapshot - to capture a stillimage. A snapshot can be triggered by the software, or by
external (with respect to the camera) hardware.

The Video mode is the normal mode when the camera is producing the image data. The
Snapshot mode forces the camera to capture a still image (a single frame).

To take a snapshot from the camera, use the Snapshot section of the camera
application main window. Remember that you need to stop video (Shift+F5) before you
turn on the snapshot mode. To start the snapshot process, press the Snapshot button.

Taking Snapshots Using Software Trigger

Note:

To make a snapshot using the software trigger:

1 Turn the video mode on (press F5 or the Start Video button in the toolbar).

2 Set exposure, gain, viewport, etc.

3 Turn the video mode off (press Shift+F5 or the Stop Video button in the toolbar).
4 Click the Snapshot button in the Snapshot section of the main window.

Snapshot
[~ Loop Snapshat
Timeout [zec) |5 %] [~ Estemal Trigger

SMX-MB2 Color Ready Stoppe

Figure 6-1 Making a snapshot using software trigger

5 The Snapshot window will open.

In the Video mode, the Exposure slider controls the exposure time for the video. When the video is stopped, the
Exposure slider controls the exposure time of the snapshot.

For continuous sequence of snapshots, use the Loop option. The stream of continuous
snapshots will be displayed in the Snapshot window. This mode can be useful to adjust
the picture parameters for the Snapshot mode.

To make a continuous sequence of snapshots:
1 Turn off the video.

Snapshots: Snapshots Basics
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2
3

4

Check the Loop box in the Snapshot section of the main window.

Click the Snapshot button. Snapshots will continuously appear in the Snapshot
window.

To stop taking snapshots, press Cancel.

Note:  lItis strongly recommended not to change any of the camera’s settings when running the Snapshot Loop mode.
This may interrupt the camera operation.

Taking Snapshots Using Hardware Trigger

To take a snapshot using a hardware trigger:

A 1 AW N

Connect an external device (equipment).

Turn the video mode off (press Shift+F5 or the Stop Video button in the toolbar).
Set exposure, gain, viewport, etc.

Set Timeout (seconds to wait for external triggering pulse).

Check the External Trigger box.

Click the Snapshot button.

Snapshot

r _!__oop\‘ Snhapshot
Timeout [zec) |5 =] W E

SMH-ME2 Color Ready Stoppe:

Figure 6-2 Taking a snapshot using the hardware trigger

7

Apply triggering pulse (See “External Trigger Connector Pinout” on page 48).

8 As aresult, the Snapshot window will open if the camera has detected the external

triggering pulse.

If it failed to detect the external triggering pulse, the Snapshot window will not open
and a timeout message will be displayed in the application status bar).

Snapshot
[~ Loop

Timeout zec) |5 %] W Estemal Trigger -

Snapshot Status: Empty Frame (Timed Zoom 1x | Stopped

Figure 6-3 Timeout message in the application status bar

External Trigger Connector Pinout

External Trigger Connector Pinout is described in the table below.

Snapshots: Taking Snapshots Using Hardware Trigger
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Pin Number Direction Signal Polarity
1 Input External trigger Positive
input 1
2 Output Frame start pulse Positive
3 - User programmed -
output
4 Input External trigger Negative
input 2
5 Output Synchronous Positive
Shutter Start
6 - Common (Ground) -

@ External trigger input 1 - an input used to trigger a snapshot by applying a positive
pulse (3.3V, duration is not less than one period of clock frequency)

@ Frame start pulse - a pulse occurs at this output when the image sensor starts scan-

ning a new frame

@ User programmed output - a user programmed output

@ External trigger input 2 - the same as the External trigger input 1, but for negative

triggering pulse

@ Synchronous shutter start - a pulse occurs at this output when the camerais in the
Snapshot mode and snapshot control sequence begins. It can be used to trigger
another camera for synchronous operation, or to activate a flash

Figure 6-4 Camera Connector View, as mounted on the camera

Setting External Trigger Polarity

The polarity of external trigger is set via the Device Setting window (press Alt+s on the

keyboard).

Snapshots: External Trigger Connector Pinout
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External Trigger Polarity

Figure 6-5 Setting the external trigger polarity

The following options are available:
@ Positive - the External Trigger Input 1 will be enabled

® Negative - the External Trigger Input 2 will be enabled.

Saving Snapshots

When you take snapshots, they are saved in directory and with file prefix specified in
Capture Options.

To change options for saving snapshots:

1 Open the Capture Options dialog by pressing Alt+c on the keyboard or go to the
File menu and select Capture Options.

SMX-M8x Capture Options @

Picture File Store Folder

C:A\UszershlgortDesklop gg

File Mame Prefizes

Single Frame |FRAME_ Fomat...

. 0 " BMP
equence _

@+ TIFF |NOME =
ideo WIDEO_

Lirnits

[~ Capture single frame as average of |2 frames

[~ Limit sequence count to |2 frames

I” Snapshot Save Onl
Capture a frame every |1 TS i 4

Save Video to Memory

Capture Limit: {100 oK, | Cancel

Figure 6-6 Snapshot saving options

2 Set the options:
a. Inthe Picture File Store Folder box, change the directory in which you want to
save snapshots or leave the default one.

Note:  This folder will also store captured videos and frames.

b. Change the prefix that will be assigned to all snapshot files or leave the default
one. Use the Snapshot field. The files are named automatically by combining the
corresponding File Name Prefix and numerical value that is calculated by the
number of last captured file + 1.

Snapshots: Saving Snapshots
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c. Selectimage file format:
® BMP - saves any 8 bit or 10 bit image as 8 bit BMP image.

® TIFF - saves 8 bit image as 8 bit TIFF image and 10 bit image as 10 bit TIFF image.
Select also compression type: NONE (without compression) or LZW (Lemple-Zif-
Welch - lossless type of compression).

Note:  The selected image format will also be used for captured frames.

d. Check the Snapshot Save Only to save snapshots without showing them on the
screen.

Press OK.

Snapshots: Saving Snapshots
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Note:

Installation

WIA

It is possible to use the SMX-M8xx cameras to get images using the Scanners and
Cameras option - standard Windows Administrative Tool (in the Control Panel, open
Scanners and Cameras).

You can use almost any of the image editing programs to get images from the SMX-
M8xx cameras. This option is available in most image editing programs. We will use an
image editing program that is always available in Windows XP - Microsoft Paint.

WIA operation with the camera is demonstrated in Windows XP operating system.

Note:

How It Works

To use the SMX-M8xx cameras for getting images, you should first install the required
software - TWAIN driver. Installing and using the TWAIN driver require that the needed
hardware for the camera is already installed (see “Installation” on page 9).

If the TWAIN driver was installed during the SMX-M8xx USB2.0 camera Software
Package installation, it is ready to be used. If not, browse to the Sumix folder, to which
the camera was installed, and open the SMX-M8x USB2.0 Camera\Drivers\TWAIN folder.
To install the TWAIN driver, run the SMX15WIA.exe application file. Wait awhile for
completing the driver installation.

The TWAIN driver is installed and ready to be used now.

The TWAIN driver is not available yet for 64 bit Windows.

Location

Open the Control Panel window (click Start>Control Panel), then open Scanners and
Cameras.

WIA
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Figure 7-1 Scanners and Cameras in the Control Panel window

Since TWAIN Driver is already installed, the SMX-M8xx Series USB2.0 Camera WIA
should be in the list.
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'=%, Scanners and Cameras E]
File  Edit Wiew Favorites Tools  Help :f
@ Back ~ () ? / ) Search {7 Folders v
Address S Scanners and Cameras 'q Go

T SME-MEY Series 1USE2.0 Camera WA
Imaging Tasks &

[ Add an imaging device

bl

Other Places

[} Control Panel

|D My Documents
|5) Shared Documents
\'-3 My Metwork Places

bl

Details

Scanners and Cameras
Syskem Folder

Figure 7-2 Viewing Scanners and Cameras

Now you can use the SMX-M8xx Series USB2.0 Camera WIA to get the image from
your camera.

Getting Image Using Scanner and Camera Wizard

To get the image using the Scanner and Camera Wizard:

1

Connect the SMX-M81M, SMX-M82C or SMX-M83C USB2.0 Camera to your com-
puter

Open Control Panel>Scanners and Cameras
Select SMX-M8x USB2.0 Camera WIA and do one of the following:

® Right-click and select Get picture using Scanner Wizard.

WIA
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‘<4, Scanners and Cameras

File  Edit View Favorites Tools  Help

@ Back = J ir J ) Search Folders Elv

Address -'} Scanners and Cameras ¥ kd 5o
-7 SMx-MB¥ Series USBZ.0 Camera HTh
Imaging Tasks & Scan
Get picture using Scanner Wizard

§_i_ et pickures

Delet
B Wiew device properties s

Rename

Properties
Other Places kS

[} Control Panel

D My Documents
|5) Shared Documents
\JJ My Metwork Places

»

Details

S5MX-M8X Series USB2.0
Camera WIA
Irnage scanner

Figure 7-3 Selecting the Scanner Wizard to get image from camera

® Double-click the selection. Welcome to the Scanner and Camera Wizard will
appear.

> Scanner and Camera Wizard

Welcome to the Scanner and Camera
Wizard

ShHMEX Series USB2.0 Camera WA

Thiz wizard helpz you copy pictures from your camera, scanner, or other
device to your computer, your network, or the Web,

To continue, click Next.

[ Mest> |[ Cancel

Figure 7-4 Scanner and Camera Wizard

WIA
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4 Click the Next button to go to the next step of the Scanner and Camera Wizard.

> Scanner and Camera Wizard
Choose Scanning Preferences
Choose your scanning preferences, and then click Preview to see how your preferences affect
the picture.
Ficture type:
------------------------------------- |
Custom gettings E
B
[ < Back ” Mest » ] [ Cancel ]

Figure 7-5 Scanner and Camera Wizard: selecting the scanning preferences

5 Select Picture Type and adjust the image's settings:

Choose Scanning Preferences ;,/'
Choase your scanning preferences, and then click Preview ta see how your preferences affect [

>

the picture.
Ficture type: |
[ Properties
I. Acivanced I.'-.'roperties_
4 Appearance
I- Brightness:
4 ‘J =
Contrast:
J o
Fesolution [DPI): F'ic:turet._l.,lpe: -
150 : Calar picture :v."
o) (oot J [en

Figure 7-6 Scanner and Camera Wizard: Advanced Properties

@ Color picture - to get the colorimage

® Grayscale picture - to get the black-and-white image

6 Click the Custom Settings button to adjust properties of the image

WIA
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5 Scanner and Camera Wizard
Choose Scanning Preferences ;,"
Choase your scanning preferences, and then click Preview ta see how your preferences affect

the picture.
Ficture type:

(O Colar picture
(O Grayscale picture
(&) Custom

Custom gettings

|

[ <Back || Mest> |[ Cancel ]

Figure 7-7 Scanner and Camera Wizard: preview

7 Click the Preview button to view the image from the camera to be scanned.
8 Resize the image if needed.
9 Click the Next button to go to the next step of the Scanner and Camera Wizard.

> Scanner and Camera Wizard
Picture Name and Destination 5
Select a name and destination for your pictures, [4

1. Tuvpe aname for thiz group of pictures:

Picture] [v]
2. Select a file format;
] TIF [TIF File] ||

3. Choose a place to save thiz group of pictures:

<o i

[ < Back ” Mest » ][ Cancel ]

Figure 7-8 Scanner and Camera Wizard: picture name and destination

10 Enter the name, select file format and specify the location where you want to save
your picture.

11 Click the Next button - the Scanner and Camera Wizard starts scanning the picture.

WIA
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Z> Scanner and Camera Wizard
Scanning Picture ;,"
Fleaze wait while the wizard scans your picture, [4

Location:

gram FileghSumixhShx-ME<LUSE2 0 Camera\DATA

Picture:
Picture 004

Ficture progress: 100% complete

To stop copying, click Cancel.

Figure 7-9 Scanner and Camera Wizard: scanning picture

12 After the Wizard finishes scanning the picture, you will be asked for other options of
the picture. Select the last option and click the Next button.

> Scanner and Camera Wizard

Other Options
*Y'ou can chooge to keep working with your pictures.

“Your pictures have been successfully copied to your computer or network.
*f'ou can alzo publish these pictures to a Web site or order printz online.

‘what do you want to do’?

(O Publizh these pictures to a'wWeb site
(O Order prints of these pictures from a phato printing 'web site

(®Mothing, I'm finished warking with these pictures

Leam mare about working with pictures.

[ < Back ” Mest » ][ Cancel

Figure 7-10 Scanner and Camera Wizard: other options

8. On the last step of the Scanner and Camera Wizard click the Finish button.

WIA
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> Scanner and Camera Wizard

Completing the Scanner and Camera
Wizard

1 picture(s] were copied.

To zee your pictures on your computer or network,, click the location
below:
CAF

To cloze thiz wizard and see your pictures, click Finish.

I <Back |} Finish |I Cancel

Figure 7-11 Completing the Scanner and Camera Wizard

Microsoft Windows will open the folder, where you saved your scanned image.

Getting Image Using Scan

To get the image using Scan:

1 Connect the SMX-M81M, SMX-M82C or SMX-M83C USB2.0 Camera to your com-
puter.

2 Open Control Panel>Scanners and Cameras.
3 Right-click SMX-M8x USB2.0 Camera WIA and select Scan.

WIA
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G- Control Panel
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Camera WIA
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Figure 7-12 Scanners and Cameras: selecting Scan

4 As aresult a window with a list of available programs will appear - the programs that
are installed in your computer to launch for scanning the image.

SMX-M8X Series USB2.0 Camera WIA

Initiate & new scan.

Select the program ta launch for thiz action:

= Microsoft Scanner and Camera ‘Wizard
e

“\I_'T- Fhotoshop
25 Photoshop

[ &hways use thiz program for this action

[ Ok, H Cancel ]

Figure 7-13 Select the program to launch for Scanning

Some image editor programs that can be also used for scanning images might not be displayed in the list that is
shown (see Figure 7-13 Select the program to launch for Scanning). It might be due to the current operating sys-
tem settings or the image editing program configuration. For more information, see Help Topics of Windows
operating system about Scanners and Cameras or Help Topics of the image editing program

WIA
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5 Select the program most suitable for you and click the OK button. The selected pro-
gram will open and Scan Using SMX-M8x Series USB2.0 Camera WIA will open.

> Scan using SMX-MBX Series USB2.0 Camera WIA

What do you want to scan?

Select an option below for the type of picture pou
want to scan.

©ltsla i
E' (O Grayscale picture
(O Custom Settings

“f'ou can also: [BE - l

Adjust the guality of the scanned picture

[ Preview H Scan H Cancel ]

Figure 7-14 Scan using SMX-M8x Series USB2.0 Camera WIA

Note  Not allimage editing programs open Scan Using SMX-M8x Series USB2.0 Camera WIA window (see Figure 7-
14 Scan using SMX-M8x Series USB2.0 Camera WIA) automatically - some of them just open the program's main
window. It depends on the image editing program configuration. In this case, for more information get Help
Topic of this program.

6 Select Color or Grayscale picture or click the Adjust the quality of the scanned
picture link to change the image's settings. Click the Preview button to preview the
image to be scanned.

7 When ready, click the Scan button - the image editor will start scanning and will
show the scanned image in the current program’s window.

Getting Image from Camera Using Microsoft Paint

To get the image from the camera using Microsoft Paint program:
1 Open Microsoft Paint (click Start>All Programs>Accessories>Paint).

2 Connect the SMX-M81M, SMX-M82C or SMX-M83C USB2.0 Camera to your com-
puter.

3 In Microsoft Paint, open File>From Scanner or Camera... - Scan Using SMX-M8x
Series USB2.0 Camera WIA will open.

WIA
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Figure 7-15 Getting image from camera using Microsoft Paint program

4 Adjust the image's settings, click Preview to view the image that is scanning.

WIA
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For Help, click Help Topics on the Help Menu.

Figure 7-16 Microsoft Paint: Image received after scanning

5 When ready, click the Scan button.
6 When done, save the scanned image.

Note:  To get more information about Scanners and Cameras operation, see standard Window's XP Help Topics
about it.

WIA



USE OF ACCESSORIES

SMX-M8xx Series cameras can be supplied with the following accessories:
1. C-mount adapter

2. C-mount adapter with IR-cut filter

3. Tripod adapter

4. USB A to Mini B cable

This chapter will show you how to use the cameras with adapters.

Using C-mount Adapter with IR-cut Filter

The SMX-M8xx Series cameras can be a C-mount (with the adapter/adapter with filter)
or a CS-mount (without the adapter/adapter with filter).

IR-cut Filter Characteristics
The IR-cut filter provided with the camera has the following characteristics:
® Diameter = 20mm
® Thickness =2 mm

Chart of the IR-cut filter transmission characteristics:

Use of Accessories
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C-mount

Use of Accessories
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In this case, the camera is used with the C-mount adapter or with the C-mount adapter

with IR-cut filter:
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C-mount: with
C-mount adapter or
C-mount adapter
with IR-cut filter

CS-mount: without
both C-mount
adapter and C-mount
adapter with IR-cut fil-
C-mount adapter with ter

IR-cut filter or without
IR-cut filter

\‘

Using Adapter with Color Cameras. Since the SMX-M8xx color cameras are sensitive
to IR-light, use the C-mount adapter with IR-cut filter for the color camera models to
make colors of the image more realistic.

Many light sources, including the sun, emit infrared light, so the color camera in daylight
will see a significant amount of infrared light without the IR-cut filter. As a result,
strange, non-realistic colors appear.

Another reason for using the IR-cut filter is the limited color correction for many lenses.
that have different depth of focus for the visible and infrared spectrum. The IR-cut filter
cuts away a significant amount of the overall collected light and thereby affects the
sensitivity in a negative way. In general, color cameras are one factor less sensitive
compared to monochrome (depending on the sensor). This is primarily due to the IR-cut
filter.

Using Adapter with Monochrome Cameras. SMX-M8xx monochrome cameras (the
SMX-M81M cameras) are more sensitive to infrared light than color models. Using the
cameras in the environment rich for infrared light may result in highlighted images. To
avoid this effect, use the C-mount adapter with IR-cut filter for monochrome cameras.

Use of Accessories
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CS-mount

In this case, the camera is used without both C-mount adapter and C-mount adapter
with IR-cut filter:

CS-mount:
without C-mount
adapter

Converting the Camera from CS-mount to C-mount or from C-mount to CS-mount

Usually the SMX-M8xx camera goes with the C-mount adapter or C-mount adapter with
IR-cut filter already screwed in.

® To use the SMX-M8xx camera as CS-mount, screw the C-mount adapter/C-mount
adapter with IR-cut filter out.

® To use the SMX-M8xx camera as C-mount, screw the C-mount adapter/C-mount
adapter with IR-cut filter in.

Note  Itis recommended to screw in (as well as screwing out) the C-mount adapter/C-mount adapter with IR-cut filter,
lens or the camera's cover when the camera is facing down or when the camera is in horizontal position - to pre-
vent the sensor contamination

Use of Accessories
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Using Tripod Adapter

The SMX-M8xx camera may go with the Tripod adapter already put on:

To remove the tripod adapter from the camera:
1 Loosen the screw of the adapter.
2 Remove it from the camera:

Use of Accessories
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To put the tripod adapter on the camera:
1 Loosen the screw of the adapter.

2 Put the Tripod adapter on the camera. Locate the tripod on the camera as shown in
the image below:

Use of Accessories
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KEYBOARD SHORTCUTS

Keyboard shortcut Description
F1 Help
F2 Captures a frame into bitmap file
F3 Captures a sequence of frames into bitmap files
F4 Captures a sequence of frames into AV file
Shift + F4 Capture a sequence of frames into the memory
F5 Starts live video display in the View window
Shift+F5 Stops live video display and closes the View window
F9 Takes a snapshot
F12 Brings up the Main window when displaying the live video
Esc The same as Shift + F5, stops the video
Ctrl+ O Opens Camera Profile
Ctrl +S Stores Camera Profile
Ctrl+C Copies an image from the camera to buffer
Alt+C Brings up the Capture Options dialog box
Alt+S Brings up the Device Settings dialog box
Alt+V Brings up the Viewport Settings dialog box
H Brings up the Histogram
w Performs White Balance (Soft) using Color Balance
Alt+W Performs White Balance (Hard) using Gain Controls
Numpad +/- Zoom In/Zoom Out the picture in the View window
Numpad * Restores the picture in the View window to its original (100%) size

Keyboard Shortcuts:
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Keyboard Shortcuts:



TOOLBAR OVERVIEW

The most common menu commands are duplicated on the application toolbar:
Starts live video display in the View window

Stops live video display and closes the View window

Brings up the Viewport Setup dialog box

Captures a frame into BMP/TIFF file

Captures a sequence of frames into BMP/TIFF files

Starts saving Video to a file

2 | |a |8 |2 |o |v

Starts saving Video to memory

Toolbar Overview:
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